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 Методические указания предназначены для развития прак-

тических навыков работы с системой схемотехнического проек-

тирования OrCAD при разработке приемопередающих устройств 

радиостанций. По лабораторным работам приво-дятся краткие 

теоретические сведения, описание лаборатор-ной работы, лабора-

торные задания. 

 

Предназначены для проведения лабораторных работ по 

дисциплине «Проектирование и технология устройств телеком-

муникаций» для студентов 3 курса. 
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Лабораторная работа №3 

 

 

СТРУКТУРА И ВОЗМОЖНОСТИ ПАКЕТА OrCAD. 

СОЗДАНИЕ ПОСАДОЧНЫХ МЕСТ КОМПОНЕНТОВ 

 

1.ОБЩЕЕ ОПИСАНИЕ РАБОТЫ 

 

1.1. Цель работы – изучение назначения, организации, 

функционирования пакета OrCAD и создание в нем посадоч-

ных мест компонентов. 

 

1.2. Содержание работы 

 

Лабораторная работа состоит из домашнего и лабора-

торного заданий. Домашнее задание заключается в изучении 

назначения и возможностей комплекса OrCAD, правил созда-

ния посадочных мест компонентов. Лабораторное задание 

включает создание посадочных мест компонентов в графиче-

ском редакторе OrCAD Layout. 

 

1.3. Используемое оборудование 

 

Для выполнения лабораторной работы используется 

ПЭВМ типа IBM PC, цветной монитор с графическим адапте-

ром VGA и выше. 

 

2. Домашнее задание и методические указания по его 

выполнению 

 

По методическому руководству ознакомится с назначе-

нием, организацией и возможностями пакета OrCAD, правила-

ми создания посадочных мест компонентов в графическом ре-

дакторе схем OrCAD Layout. 
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2.1. Создание посадочных мест компонентов 

 

Для создания посадочных мест компонентов необходи-

мо после запуска OrCAD Layout в меню выбрать пункт Library 

Manager (рис. 1). В открывшемся окне выбрать Create New 

Footprint (создание нового посадочного места) (рис.2). 

 

Рис. 1. Окно программы OrCAD Layout 

Рис. 2. Создание посадочного места 



 6 

 

Далее необходимо следовать указаниям появляющимся 

на экране: установить метрическую систему счисления, впи-

сать в соответствующее поле название создаваемого посадоч-

ного места. В результате откроется окно редактора, для созда-

ния посадочного места (рис. 3). 

                                                    а 

                                                     б 
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                                                    в 

 

Рис. 3. 

 

В редакторе необходимо расположить контактные пло-

щадки в соответствии с конкретными размерами компонента, 

нарисовать контур компонента (рис. 4). 

После выполнения перечисленных операций, необхо-

димо сохранить посадочное место в библиотеке. Название 

библиотеки должно совпадать с шифром учебной группы. 
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Рис. 4. 

 

 

3. ЛАБОРАТОРНОЕ ЗАДАНИЕ 

 

3.1. Создать библиотеку посадочных мест компонентов, 

используя в качестве имени библиотеки обозначение группы. 

3.2. Создать посадочные места в графическом редакторе 

OrCAD Layout: 

- резистор (0805, МЛТ-0,125); 

- конденсатор (К10-17б); 

- транзистор (КТ315, КТ361); 

- диод (КД522). 

 

4. УКАЗАНИЯ ПО ОФОРМЛЕНИЮ ОТЧЕТА  

И КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

4.1. Отчет по лабораторной работе должен содержать: 
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- наименование и цель работы; 

- распечатка созданных посадочных мест. 

 

4.2. Контрольные вопросы к лабораторной работе 

 

1.Цель выполнения лабораторной работы. 

2. Этапы создания нового посадочного места выводного 

компонента. 

3. Этапы создания нового посадочного места компонен-

та с планарными выводами. 

 

 

 

Лабораторная работа №4 

 

 

СТРУКТУРА И ВОЗМОЖНОСТИ ПАКЕТА OrCAD. 

РАЗРАБОТКА ТОПОЛОГИИ ПЕЧАТНЫХ ПЛАТ 

 

1.ОБЩЕЕ ОПИСАНИЕ РАБОТЫ 

 

1.1. Цель работы – изучение назначения, организации, 

функционирования возможностей пакета OrCAD и разработку 

топологии печатных плат. 

 

1.2. Содержание работы 

 

Лабораторная работа состоит из домашнего и лабора-

торного заданий. Домашнее задание заключается в изучении 

назначения и возможностей комплекса OrCAD, правил созда-

ния печатных плат. Лабораторное задание включает создание 

печатной платы в графическом редакторе OrCAD Layout. 

 

1.3. Используемое оборудование 
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Для выполнения лабораторной работы используется 

ПЭВМ типа IBM PC, цветной монитор с графическим адапте-

ром VGA и выше. 

 

2. Домашнее задание и методические указания по его 

выполнению 

 

По методическому руководству ознакомится с назначе-

нием, организацией и возможностями пакета OrCAD, правила-

ми трассировки печатных плат в графическом редакторе 

OrCAD Layout. 

 

2.1. Назначение и возможности пакета OrCAD Layout. 

 

Наиболее естественный способ разработки печатной 

платы (ПП) состоит в создании ее схемы с помощью одного из 

графических редакторов, например OrCAD Capture, и создания 

списка соединений схемы в формате, приемлемом для OrCAD 

Layout.  

Разработка новой ПП начинается после загрузки OrCAD 

Layout (см. команды ее начального режима) и выполнения ко-

манды File>New. Сначала запрашивается имя технологическо-

го шаблона ПП (расширение имени файла *.ТСН или *.TPL, 

рис. 5, а). Затем — имя файла списка соединений *.MNL (рис. 

5, б). В заключение указывается имя файла создаваемой ПП 

*.МАХ (рис. 5, в).  

 

Команды OrCAD Layout Plus в начальном режиме:  

Import - Импорт файлов ПП других САПР: 

MIN Interchange - Преобразование текстового файла 

*.MIN в бинарный файл *.МАХ; 

MAX ASCII to MNL - Преобразование текстового файла 

списка связей *.ASC в бинарный файл *.MNL; 
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РСВ II Netlist - Преобразование текстового файла списка 

связей *.NET системы P-CAD в бинарный файл *.MNL; 

Futurenet Netlist - Преобразование текстового файла спи-

ска связей формата программы Futurenet в бинарный файл 

*.MNL. 

PCB386+ PCB - Преобразование файлов формата OrCAD 

PCB386 в файлы *.МАХ; 

CadStar PCB - Преобразование файлов формата CadStar 

в файлы *.МАХ; 

PADS PCB - Преобразование файлов формата PADS в 

файлы *.МАХ; 

PCAD PCB - Создание файла ПП *.МАХ после загрузки 

файлов *.PDF, *.TCH, pcad.ini и pcad.tbl; 

Protel PCB - Преобразование файлов *.РСВ системы 

Protel в файлы *.МАХ; 

Tango PCB - Преобразование файлов *.РСВ систем Tango 

Series II или Tango_PCB Plus в файлы *.МАХ; 

DXF to Layout - Преобразование файлов *.DXF из 

AutoCAD в формат *.МАХ; 

IDF to Layout - Преобразование файлов *.BRD системы 

Pro/Engineer в файлы *.МАХ; 

SPECCTRA to Layout - Преобразование файлов *.RTE в 

файлы *.МАХ; 

GenCAD to Layout - Преобразование файлов *.CAD сис-

темы VeriBest в файлы *.МАХ; 

Export - Экспорт файла базы данных печатной платы в другой 

формат: 

МIN Interchange - Преобразование бинарного формата 

базы данных ПП (файлы *.МАХ) в ASCII (файлы *.MIN); 

MAX to ASCII Netlist - Преобразование бинарного фор-

мата списка связей (*.MNL) в формат ASCII (*.ASC); 

РСВ386+ - Преобразование в формат РСВ386; 

CadStar PCB - Преобразование в формат программы 

CADStar (файлы *.CDI); 

PADS PCB - Преобразование в формат программы PADS; 
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PCAD PCB - Внесение корректировки в PDIF-файл после 

изменений в файле *.МАХ; 

Protel PCB - Преобразование в формат Protel; 

Tango PCB - Преобразование в формат Tango; 

Layout to DXF - Преобразование файлов *.МАХ в фор-

мат AutoCAD; 

Layout to IDE - Преобразование в формат Pro/Engineer; 

Layout to GenCAD - Преобразование в формат GenCAD; 

Layout to IPC-356 - Преобразование в формат IPC-D-356; 

Export: 

Layout to SPECCTRA - Преобразование в формат 

SPECCTRA. 

Exit (Alt+F4) - Выход из программы. 

View (Просмотр): 

Toolbar - Вывод пиктограмм команд; 

Status Bar - Вывод в основное меню строки состояний 

Tools (Инструменты): 

Library Manager - Вызов менеджера библиотек; 

OrCAD Capture - Вызов программы OrCAD Capture; 

Visual CADD - Вызов программы Visual CADD; 

Smart Route - Вызов автотрассировщика Smart Route; 

Gerb Tool - Вызов программы Gerb Tool: 

New - Создание нового Gerber-файла; 

Open... - Загрузка Gerber-файла; 

ECO's - Корректировка ПП по изменениям, внесенным на схе-

ме или на другой ПП: 

Auto ECO - Добавление и удаление компонентов и цепей 

без переписывания атрибутов ПП; 

Auto ECO/Override Attrs. - Создание новой ПП или 

включение новых компонентов на старую; 

Auto ECO/Override Coords - Создание новой ПП или 

включение новых компонентов на старую ПП с перепи-

сыванием всех координат размещения; 
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Auto ECO/Override All - Создание новой ПП или вклю-

чение новых компонентов на старую ПП с переписывани-

ем всех атрибутов и координат размещения; 

Auto ECO/Add Only - Добавление компонентов и цепей 

без переписывания атрибутов; 

Auto ECO/Add Override - Добавление компонентов и 

цепей и обновление их параметров; 

Auto ECO/Net Attrs. - Передача из одной ПП в другую 

атрибутов цепей и правил их трассировки. 

Edit App Settings - Редактирование файла настройки конфигу-

рации программы Layout (файл Lsession.ini). 

Reload App Settings - Перезагрузка файла настройки конфигу-

рации программы Layout после его редактирования. 

Help (Помощь): 

Help Topics.., (Fl) - Вывод содержания, предметного указателя 

и средств поиска терминов встроенной инструкции; 

Learning Layout - Вызов электронного учебника по OrCAD. 

Layout 
About Layout... - Вывод номера версии программы и ее реги-

страционного номера. 
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Рис. 5. Загрузка списка соединений при создании новой 

ПП  

 

 

Список ошибок, возникших при загрузке списка соединений, 

выводится в текстовый файл 

<имя_файла_списка_соединений>.ЕRR (см. рис. 6).  

 

 

 

 

 

 

 

 

Рис. 6. Отчет о результатах загрузки списка соединений  

 

В процессе загрузки списка соединений для каждого 

символа схемы в библиотеках корпусов компонентов *.LLB 

(Footprint Libraries) отыскивается соответствующий корпус. 
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Это соответствие указывается с помощью атрибута символа 

РСВ Footprint.  

Если в процессе загрузки списка соединений обнаружен 

компонент, не имеющий ссылок на его корпус, то выводится 

диалоговое окно для его определения. После нажатия на па-

нель Link existing footprint to component (Укажите имя суще-

ствующего типового корпуса) открывается диалоговое окно, в 

котором выбирается имя библиотеки и затем имя корпуса, изо-

бражение которого просматривается в правой части окна.  

Технологические шаблоны (Technology templates, файлы 

с расширением имени *.ТСН или *.TPL) содержат начальную 

информацию о ПП: зазоры и сетка трассировки, данные о кон-

тактных площадках (КП) и переходных отверстиях ( ПО) и т.п. 

В дальнейшем все эти установки можно изменить по отдельно-

сти или загрузить новый шаблон после создания ПП. В резуль-

тате загрузки технологического шаблона в текущий проект 

вносятся следующие изменения:  

загружаются стратегии размещения компонентов и трас-

сировки проводников, замещая предыдущие данные;  

устанавливается новая структура слоев ПП;  

изменяются размеры шагов всех сеток:  

изменяются параметры всех стеков контактных площа-

док (СКП) выводов компонентов и ПО.  

Для создания файла технологического шаблона необхо-

димо создать файл ПП, выполнив необходимые установки, и 

сохранить его с явным указанием расширения имени ТСН или 

TPL.  

Вместе с OrCAD Layout поставляется ряд шаблонов, в 

частности:  

lbet_any.tch — для ПП, предназначенных для установки 

компонентов как со штыревыми, так и с пленарными выводами 

(между выводами стандартных корпусов DIP допускается про-

кладка одной трассы);  
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2bet_thr. tch — для ПП, предназначенных для установки 

компонентов со штыревыми выводами (между выводами стан-

дартных корпусов DIP допускается прокладка двух трасс);  

3bet_any. tch — для ПП, предназначенных для установки 

компонентов как со штыревыми, так и с планарными выводами 

(между выводами стандартных корпусов DIP допускается про-

кладка трех трасс);  

_default. tch — шаблон по умолчанию; после его загруз-

ки можно установить другой набор слоев ПП и все остальные 

параметры;  

jump6035.tch — односторонняя ПП, в которой исполь-

зуются ПО с внешним диаметром 60 мил и отверстиями диа-

метром 35 мил;  

metric.tch — ПП, для которых используется метрическая 

система единиц;  

protel.tch — для ПП, созданных в пакете Protel.  

После успешного завершения загрузки списка соедине-

ний на рабочем экране OrCAD Layout изображаются корпуса 

компонентов текущего проекта с указанием их электрических 

соединений, как на примере показано на рис. 6.4.  

Перечень команд программы OrCAD Layout Plus в ре-

жиме разработки ПП и их краткое описание приведен ниже. 

Команды каждого меню перечислены в том порядке, в котором 

они расположены.  

Наиболее употребительные команды имеют пиктограм-

мы быстрого вызова. Однако две пиктограммы не имеют соот-

ветствующих команд. Это пиктограммы включения режима 

текущей проверки DRC и отключения видимости электриче-

ских связей. Состояния этих режимов отображаются в строке 

заголовка основного меню (рис. 7): DRC ON/OFF, 

RECONNECT ON.  
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Рис. 7. Результат загрузки списка соединений на печат-

ную плату 

 

Команды OrCAD Layout Plus в рабочем окне: 

Меню File (Файл): 

New... (Ctrl+N) - Создание проекта новой ПП с загрузкой 

файлов шаблона ПП и списка соединений; 

Open (Ctrl+O) - Открытие существующего проекта ПП; 

Load... - Загрузка файла стратегии авторазмещения и ав-

тотрассировки (*.SF); 

Save (Ctrl+S) - Сохранение внесенных изменений в те-

кущем проекте; 

Save As... - Сохранение внесенных в проект изменений в 

новом файле; 

Backup - Последовательная запись копий текущего файла 

ПП в 5 файлах BACKUP1.MAX — BACKUP5.MAX; 

Close - Закрытие текущего проекта; 
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Print/Plot... (Ctrl+P) - Непосредственный вывод на прин-

тер /плоттер; 

Library Manager (Ctrl+I) - Вызов менеджера библиотек; 

Text Editor... - Вызов программы NotePad для просмотра 

и редактирования текстовых файлов; 

1, 2, ... - Список файлов; 

Exit (Alt+F4) - Выход из программы Layout; 

Меню Edit (Редактирование): 

Undo (U) - Отмена последней команды; 

Copy (Ctrl+C) - Копирование объектов, выбранных в ок-

не, с занесением их в буфер обмена; 

Paste (Ctrl+V) - Размещение на ПП объектов из буфера 

обмена; 

Delete (Ctrl+X) - Удаление объектов, выбранных в окне; 

Find/Goto... (Ctrl+F) - Поиск компонента по его позици-

онному обозначению или переход в точку с заданными 

координатами; 

Select Any... (Alt+S) - Выбор компонента по его позици-

онному обозначению; 

Select Next (N) - Выбор для размещения на ПП следую-

щего компонента; 

Clear Selections - Отмена выбора компонентов в элек-

тронной таблице; 

End Command - Завершение команды; 

Properties... (Ctrl+E) - Опрос и редактирование парамет-

ров выбранного объекта; 

Меню View (Просмотр): 

Design - Нормальное изображение ПП; 

Density Graph - Вывод гистограммы плотности располо-

жения компонентов; 

Preview - Предварительный просмотр слоя, выбранного в 

таблице Post Process; 

High Contrast (.) - Изменение контрастности изображе-

ния; 
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Clear Screen (Backspace) - Очистка экрана (без стирания 

файла ПП); 

Redraw (Home) - Перечерчивание экрана; 

Query Window... - Вывод окна опроса компонентов; 

Database Spread Sheets - Вывод электронных таблиц: 

Components (Shift+C) – Компонентов; 

Package (Shift+K) - Упаковочной информации; 

Footprints (Shift+F) – Корпусов; 

Padstack (Shift+T) - Стеков КП и ПО; 

Apertures (Shift+P) – Апертур; 

Layers (Shift+Y) – Слоев; 

Nets (Shift+N) – Цепей; 

Obstacles (Shift+O) – Барьеров; 

Text (Shift+X) - Текстовых переменных; 

Error Markers (Shift+M) - Маркеров ошибок; 

Drills (Shift+R) – Отверстий; 

Post Process (Shift+S) - Список заданий вывода на пери-

ферийные устройства с возможностью предварительного 

просмотра их графики; 

Statistics (Shift+I) - Статистические данные о ПП; 

Zoom All (Fit) (Shift+Home) - Вывод на экран полного 

изображения ПП; 

Zoom In (I) - Увеличение масштаба изображения; 

Zoom Out (О) - Уменьшение масштаба изображения; 

Zoom Previous - Вывод предыдущего изображения; 

Zoom DRC/Rout Box (B) - Вывод на полный экран изо-

бражения, находящегося внутри области DRC/Rout Box; 

Select Layer... - Выбор слоя; 

Visible<> Invisible (-) - Переключатель видимости слоя; 

Меню Tools (Инструмент): 

Layers - Работа со слоями: 

Select... - Выбор слоя по имени; 

Select From Spreadsheet... - Выбор слоя из электронной 

таблицы; 

Unroute - Отмена трассировки на текущем слое; 
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Properties... (Ctrl+E) - Просмотр и редактирование 

свойств текущего слоя; 

Cluster - Работа с кластером: 

Make (К) - Включение компонента в кластер; 

Break (Ctrl+K) - Восстановление первоначальной формы 

всех компонентов, входящих в кластер; 

Group - Работа с группой: 

Select Filtered... - Включение компонента в группу раз-

мещения; 

New... - Выбор следующего компонента для размещения; 

Opposite (T) - Перенос компонента на противоположную 

сторону ПП; 

Rotate (R) - Вращение компонента; 

Lock (L) - Временная фиксация компонента или группы; 

Fix - Постоянная фиксация компонента или группы; 

Properties... (Ctrl+E) - Свойства компонента; 

Delete (Ctrl+X) - Удаление компонента; 

Matrix - Работа с графической матрицей размещения компо-

нентов: 

Select Tool - Режим выбора рисования матрицы; 

Delete (Ctrl+X) - Удаление выбранной строки или столб-

ца матрицы; 

Component - Работа с компонентами: 

Select Tool - Режим выбора компонента; 

Select Filtered... - Выбор нескольких компонентов с по-

мощью фильтра имени; 

Select From Spreadsheet... - Выбор из таблицы; 

Queue For Placement - Создание очереди для размеще-

ния; 

Place... - Размещение компонента; 

New.:. - Добавление в проект нового компонента; 

Copy - Копирование компонента; 

Adjust (Ctrl+J) - Выравнивание группы компонентов; 

Opposite (T) - Перенос компонента на противоположную 

сторону ПП с его зеркальным отображением; 
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Rotate (R) - Поворот на 90°; 

Shove (J) - Разрешение трассировщику передвигать ком-

поненты; 

Swap (Ctrl+W) - Разрешение трассировщику перестав-

лять секции; 

Lock (L) - Временная фиксация; 

Fix - Постоянная фиксация; 

Alternate Footprint... - Выбор альтернативного корпуса; 

Properties... (Ctrl+E) - Просмотр и редактирование 

свойств; 

Delete (Ctrl+X) – Удаление; 

Package - Работа с упаковочной информацией: 

Select From Spreadsheet... - Выбор из таблицы; 

Properties... (Ctrl+E) - Просмотр и редактирование 

свойств; 

Gate - Работа с секциями компонентов: 

Select Tool - Режим выбора; 

Swap (Ctrl+W) - Перестановка логически эквивалентных 

секций; 

Footprint - Работа с корпусами компонентов: 

Select From Spreadsheet... - Выбор из таблицы; 

New... - Создание нового корпуса; 

Padstack - Работа со стеками КП и ПО: 

Select From Spreadsheet... - Выбор из таблицы; 

New... - Создание нового стека; 

Copy Layer... - Копирование КП с одного слоя на другой; 

Copy to Library... - Занесение СКП в существующую или 

создаваемую библиотеку; 

Properties... (Ctrl+E) - Просмотр и редактирование 

свойств; 

Delete (Ctrl+X) - Удаление неиспользуемых в проекте 

СКП; 

Pin  - Работа с выводами компонентов: 

Select Tool - Режим выбора; 

Copy (Ctrl+C) – Копирование; 
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Rotate (R) - Поворот на 90°; 

Swap (Ctrl+W) - Перестановка логически эквивалентных 

выводов; 

Toggle Copper Pour Seed - Назначение области металли-

зации в качестве КП; 

Properties... (Ctrl+E) - Просмотр и редактирование 

свойств; 

Delete (Ctrl+X) – Удаление; 

Aperture  - Работа с апертурами: 

Select From Spreadsheet... - Выбор из таблицы; 

New... - Создание новой апертуры; 

Properties... (Ctrl+E) - Просмотр и редактирование 

свойств; 

Delete (Ctrl+X) – Удаление; 

Net - Работа с цепями: 

Select From Spreadsheet... - Выбор из таблицы; 

Unroute - Отмена трассировки цепи; 

Unroute Partial Track - Отмена трассировки части цепи; 

Unlock (Ctrl+L) - Отмена фиксации цепи; 

Lock (L) - Фиксация цепи; 

Enable/Disable - Выбор /отмена выбора цепи. 

 

Базы данных печатных плат также можно импортиро-

вать из других пакетов по команде File>Import. 

Данные из OrCAD Layout возможно передавать в про-

грамму SPECCTRA, как для выполнения размещения компо-

нентов, так и для трассировки проводников в ручном, интерак-

тивном или автоматическом режимах. Однако ПП можно пол-

ностью разработать и с помощью OrCAD Layout. В начале по 

команде Options>System Settings (Ctrl+G) в диалоговом окне 

на рис. 8 просматривают и при необходимости редактируют 

глобальные параметры проекта:  

Display Units - выбор системы единиц (Miles, Inches, 

Milimeters, Centimeters);  
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Display Resolution — разрешающая способность изо-

бражения в декартовой системе координат;  

Rotation - поворот объектов (угол поворота при выпол-

нении команды Rotate и угловая разрешающая способность);  

Workspace Settings — размеры рабочей области.  

 

 

Рис. 8. Редактирование параметров проекта 

 

Затем по команде View >Database Spreadsheets>Layers 

в диалоговом окне на рис. 6.6 просматривают и при необходи-

мости редактируют перечень слоев ПП и их назначение. Редак-

тирование слоев производится с помощью меню, раскрываю-

щихся после щелчка правой кнопкой мыши (рис. 9).  

Слои ПП могут быть следующих типов:  

 Routing — трассировки;  
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 Plane — металлизации (обычно слои «земли» и 

«питания»); изображаются негативным образом (участки ме-

таллизации высветлены, а участки освобождения затемнены), 

что нужно принимать во внимание при изготовлении  

 Drill — символов отверстий;  

 Jumper — перемычек;  

 Documentation — документирования;  

 Unused — неиспользуемый слой.  

 

 

Рис. 9. Конфигурирование слоев ПП  

 

ПП по умолчанию содержит два наружных слоя (ТОР, 

ВОТ), два слоя металлизации (GND, POWER), 12 внутренних 

слоев (INNER1, ..., INNER12), слой символов отверстий DRILL 

и 10 слоев документирования. Слои можно переименовывать, 

изменять их тип, добавлять новые, их нельзя только удалять. 
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Каждый слой помимо основного имени Layer Name (например 

TOP, BOTTOM, INNER1) имеет трехсимвольное уменьши-

тельное имя NickName (TOP, ВОТ, GND, IN1 и др.), которое не 

редактируется. Дополнительный слой Global Layer предназна-

чен для отображения электрических связей.  

При наличии в проекте планарных компонентов в графе 

Mirror Layer для каждого слоя при необходимости указывается 

имя слоя, на который переносится соответствующая информа-

ция при переносе компонента на противоположную сторону 

ПП.  

Далее по команде View >Database Spreadsheets> 

Padstacks в диалоговом окне на рис. 10 просматривают и при 

необходимости редактируют перечень СКП — стеков контакт-

ных площадок (КП) выводов компонентов и переходных от-

верстий (ПО).  

Диалоговое окно редактирования параметров 

(Properties) КП и ПО показано на рис, 11. На нем расположены 

следующие панели:  

Non-Plated — признак наличия сквозного отверстия;  

Use For Test Point — признак использования ПО в ка-

честве контрольной точки (test point);  

Large Thermal Relief — признак использования КП в 

качестве большого теплового барьера, располагаемого на слое 

металлизации;  

Pad Shape (форма КП):  

Round — круглая;  

Square — квадратная;  

Oval — овальная;  

Annular — в виде кольца (не рекомендуется использо-

вать на слоях металлизации);  

Oblong — продолговатой формы со скругленными 

краями;  

Rectangle — прямоугольная;  

Thermal Relief -- тепловой барьер;  
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Undefined — не определена (этот признак имеют КП 

пленарных компонентов на всех слоях, кроме слоя ТОР);  

No Connection — невозможность подключения к КП 

электрических цепей (используется для блокировки подключе-

ния цепей на определенных слоях;  

Pad Width — ширина КП;  

Pad Height — длина КП;  

X/Y Offset — смещение точки подключения трассы от-

носительно геометрического центра КП по осям X/Y.  

 

Рис. 10. Таблица СКП и ПО 
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Рис. 11. Диалоговое окно редактирования контактных 

площадок 

 

При этом для ПО допускается только 3 типа КП: Round, 

Square и Undefined.  

Перед выполнением размещения компонентов или трас-

сировки проводников необходимо вычертить контур. ПП Board 

outline. Для этого в меню Tool выбирается команда Obstacle и 

вычерчивается замкнутый многоугольник; тип барьера (в дан-

ном случае Board Outline), слой размещения и толщина линий 

контура которого задается в диалоговом окне, показанном на 

рис. 12, а. По этой же команде задаются барьеры размещения 

или трассировки других типов и области металлизации, как на 

примере, показанном на рис. 12 б.  
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                                                 а 
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                                                б 

 

Рис. 12. Задание параметров контура ПП (а) и области 

металлизации, подсоединенной к выводу компонента (б) 

 

Обратите внимание, что пунктирным прямоугольником 

выделяется область DRC Box, внутри которой по команде 

Auto>Design Rule Check (DRC) проверяется соблюдение тех-

нологических ограничений и по другим командам меню Auto 

выполняется ряд команд автотрассировки. Для перемещения 

этой области выбирается команда View>DRC Box и затем про-

изводится щелчок левой кнопки мыши. После этого область 

DRC Box перемещается вместе с курсором, не изменяя своих 

размеров. Для изменения ее размеров после выбора команды 

View>Zoom DRC/Route Box нажимается и удерживается левая 

кнопка мыши и затем движением курсора наносится прямо-

угольная область. Наиболее естественно, когда граница облас-

ти DRC/Round Box совпадает с контуром ПП.  
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Размещение компонентов выполняется в OrCAD Layout 

вручную, по очереди выбирая, перемещая, поворачивая и пе-

ремещая компоненты на поверхности наружного слоя ПП и 

перемещая пленарные компоненты на противоположную сто-

рону. В автоматическом или интерактивном режимах разме-

щение компонентов выполняется по командам Auto>Place.  

Трассировка проводников проводится в ручном режиме 

с помощью команд Tool>Track>Select Tool и Track Segment 

или в интерактивном режиме с помощью команд 

Auto>Autoroute (Autopath Route Mode, Shove Track Mode, 

Edit Segment Mode ). При интерактивной трассировке выпол-

няется текущий контроль соблюдения допустимых зазоров, 

если включен режим Online DRC  

 

 

3. ЛАБОРАТОРНОЕ ЗАДАНИЕ 

 

 Разработать печатную плату в графическом редакторе 

OrCAD Layout, используя схему электрическую принципиаль-

ную из лабораторной работы №2.  

 

4. УКАЗАНИЯ ПО ОФОРМЛЕНИЮ ОТЧЕТА И 

КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

 4.1. Отчет по лабораторной работе должен содержать: 

  

- наименование и цель работы; 

- распечатку топологии печатной платы. 

 

4.2. Контрольные вопросы к лабораторной работе 

 

1.Какова цель лабораторной работы? 

2.Перечислите основное меню программы OrCAD 

Layuot.. 
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3.Перечислите основные команды размещения компо-

нентов на печатной плате. 

4.Способы простановки позиционных обозначений. 
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